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Tag List Generator

TAG LIST GENERATOR

TAG LIST GENERATOR and LC700 OPC Server Installation

Introduction

Required System

- Operating System - Windows NT 4.0 — Service Pack 6, Windows 2000 (Service Pack 2), or
Windows XP.

- Computer - PC —Pentium Processor 400 MHz or higher.

- RAM - 64 Mbytes (128Mbytes for Windows XP)

- Disk Space - 10 Mbytes

Preparing the Installation

Using the Smar installation CD “LC700 Software Tools”, click on the OPC Server V8 and Tag List
Generator V8 to install the LC700 OPC Server and Tag List generator respectively.

The software Tag List Generator for the LC700 OPC Server is developed to generate an information
Table to the LC700 OPC Server telling which are the Tags for each Modbus Address.

In the HMI side, just configure using links to Tags, in this way, if the user changes the LC700
configuration (the Modbus address will change), but the Tags will not. The OPC Server will be able
to read the new Tag List generated after the changes made with the CONF700.

Tag List enables the USER to enter scaled values for Tag values in engineering units. The Tag
Scaling allows the user to convert a raw value (unscaled value from the Device) to a given numeric
range (in engineering units).

Using the TreeView the USER can select, add, create, delete, and edit the List of Communications
Connections (Ports), List of Devices, Types of Conversions.

Under the Controller (Device) Level, a list of Tags will be shown, and the Properties for this Tag will
be visualized on the right Frame of the Main Application Frame.

For each Tag, the user can select if this Tag Value will have Conversion or Not and the Type of
Conversion that will apply for this Tag Value.

The versions 8.54 and later of the Tag List support the configuration of the MCT for the LC700.
MODBUS Cross Table (MCT) is a technique to optimize variable MODBUS addresses that can
significantly increase the speed of MODBUS drivers when accessing variables in a Smar LC700 or
DF65 system.

Note: This function is only available for systems with CPU-700-E3 or CPU-700-E3R.
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Using the Tag List Generator

Creating a New Project
To create a New Project, click on the File menu, then click New, or click on New button, on the
toolbar.’

[2] TaglList ¥8 for the LCT00 OPC 2.0 Server ¥8.54
File Edit ©OPC Help
Mew

Open

Save
Save bs
Export Taglisk

Close

Ezxit

C:\Program FilestSmari Taglist and LC700 OPC Server w8.54 1\ WorkinglLed08_va. TAG

Figure 1- Creating a new project

To open an existing project, to save a project or to close the current project just click on the File
menu then click on Open , Save or Close respectively, or click on the icons Open, Save or Close
(Windows standard) on the toolbar.

Adding and Removing ports
The LC700 OPC Server supports all types of port combinations (COM1,COM2, Ethernet) having
serial and Ethernet communication on the same configuration.

Once the user starts a new project, the TagList will open a window similar to Figure 2. Next, by right
clicking the Communication item, Tag List will display a window where the user can configure the
parameters described below.

File Edit OPC Help

O e @@

Remoyve Al

Figure 2- Adding a new port

The user must certify that the chosen configuration option (Baud Rate, or IP address) is the same
as the LC700 configuration, which will be monitored.
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. Connection Settings % i ﬂ

Connection

IEnet

— Settings
ScanPerod | 1.00  zec Retry Period | 1.00  zec

Timeu:uutl OO0 mEEC Retries |2 vI

— Interface

i~ Serial

CamM |'| vI Baud Rate I 9e00 VI
RTS Caontrel IDigable VI

[T CTS Dutput Contnal

& TCRAP

IP address [132 [16e [1e8 [

] | Cancel

Fig 3- Communication Parameters

Port Settings

Port Name (Connection)

The user must create a Tag for the port to be configured on the TagList. This tag will be used to
define the first Browser level on the TagList OPC Server.

Scan Period
It is the time it takes for the LC700 OPC Server to read the Tags (OPC Points) from all slave
devices, that is, the time between cyclic questions.

Retry Period
When the OPC Server Client runs out of configured tries in Retries, it verifies each time interval
established by Retry Period whether or not the connection is active.

Timeout

Waiting time for a response after a message from the LC700 Server is being sent to the slave. After
this period of time, the LC700 OPC Server retries to establish communication, based on the number
configured on Retries.

Retries
Number of times the LC700 OPC Server software will try a new communication after waiting for the
specified value on the Timeout parameter.

Specific Configuration for the serial physical mean

If the user chooses to use serial communication, it can be through EIA-232 or EIA-485. The
connection and cable specification are the same used in the communication between the LC700 e o
CONF700 and are described in the “LC700 Manual”.

Com
Allows the user to choose which serial port will be used for communication.

CTS Output Control
When this parameter is enabled, the OPC Server will transmit only when the CTS is active.

RTS Control

The options of this parameter are:
Disable: RTS inactive (off)
Enable: RTS active (on)
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Handshake: Activates the RTS, if the receiver buffer is ¥ occupied and disables when the receiver
buffer is less than half occupied.

Toggle: RTS will be activated if there are bytes to be transmitted, and RTS will be disables after
every byte is transmitted.

Specific configurations for communication via Ethernet

IP Address
In case of Ethernet TCP/IP communication, the user should set the logic controller Ethernet card’s
IP address (MB700 or ENET700) which should be communicated.

. Connection Settings x|

Connection

Enet

— Seftings
Scan Period | 1.00  zec Retry Period | 1.00  zec

Timeaut | 500 mM3ec Hetrieslz vl

— Interface

£ Serial

COM m BaudRate [ 5500 |z
RTS Contral IDisable 'I

[~ ETS Hutput Eontrol

& TCPAP

P address [132 [168 [168 [

]S | Cancel

Figure 4- Adding an Ethernet Port

Adding a New Port

The user can add more serial ports or Ethernet if required. To add a new port, right-click at
Communication Connections and select Add.

Fﬁ TagList ¥8 for the LCT00 OPC 2.0 Server ¥8.54 -

File | Edit OPC  Help
I

[ Edit

. Remave

Remove Al

Cnline

Compare MCT Tables

H 1
=] LTV

[BI) Complete Tag List

Figure 5- Adding a New Port

Editing/ Removing Ports
The user can edit or remove a communication Port, for that, just right click on the added port. So, it
is possible to change its current settings, or remove the desired port, clicking on Remove button.
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Redundancy

The LC700 OPC Server supports system redundancy. The OPC redundancy follows a main path
philosophy and a redundant path (backup). When the system detects the main path is not
communicating, the redundant path takes over communication. When communication on the main
path returns, again, it becomes the active path and the redundant gets back to being the backup.
The redundant path, even in a state of backup, it tests itself if everything is OK. Each port (main or
backup) natifies its current status through Status.

Redundancy could take place even in different physical means/data link layer: MODBUS TCP and
MODBUS RTU. For example, two Ethernet networks or even one Ethernet network and one EIA
485 network. The user can configure an existing redundant network on the system.

Application Example

Consider an application example shown in Figure A where the LC700 OPC Server monitors points
from 3 LC700 in an Ethernet network. In this case it is used path redundancy for the LC700’s, which
in case of main path fails, the LC700 OPC Server uses an alternative path for supervision.

MIC 1 (Metweork Interface Card 1) —] : ' 0= MIC 2 (Metwork Interface Card 2
— -
PORT Ml PORT RED
‘\\ =
"'\-;_\_'._‘-
[
ETHERMET 1 (Main Path)
ETHERMET 2
[Redundart Path)

I
[

=0akt

ElA-485

Figure 6- An application involving an LC700 OPC Server, LC700 and MB700.

The main path

Right after a new project is created, the Tag List Generator will ask how the LC700 OPC Server and
the LC700 will communicate. The LC700 supports the communication via serial port (232 or 485) or
via Ethernet (TCP/IP). In the case of the next figure, the main path is through the Ethernet port
("Main_Port")
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. Connection Settings

P!
Connection

[ain_par]

— Settings

ScanPenod | 1.00  =ec Retry Penod | 1.00  sec

Timeautl RO0 | mMEeC Retries |2 vl

— Interface

" Serial

COM |‘| vl Baud Rate I 3E00 "I
RTS Conbrol IDiSable "I
[T CTS Output Cantral

" TCRAP

P &ddress [192 168 [168 [ 65

Q. | Cancel

Figure 7- Choosing a communication channel

The redundant path

After configuring the main path, the user should add a new port (channel) which will be the
redundant (backup).

. Add Connection

P!
Connection
|F|edundant_|:u:urt

— Settings

ScanPenod | 1.00  =ec Retry Penod | 1.00  sec

Timeautl RO0 | mMEeC Retries |2 vl

— Interface

" Serial

COmM |‘| vl Baud Rate I 3E00 "I
RTS Conbrol IDiSable "I
[T CTS Output Cantral

" TCRAP

IP Address [132 [168 168 [ 21

Q. | Cancel

Figure 8- Adding aredundant port
Adding or Removing a Configuration

Before adding a new configuration, the user is supposed to create a configuration in the CONF700
software.

If the user has several LC700’s with different addresses, a configuration file should be generated
(*.PL7, *.PL8) with a different name for each LC700 used in the project.
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Adding a Configuration

A

The configuration must be a valid configuration generated by CONF700 from Smar.

To add a new configuration the user should open the menu Edit > Add or in the left pane of the

Tag List Application.

H TagList ¥& for the LCT00 OPC 2.0 Server v8.54

File Edit ©OPC Help

D Heg| o« @ e

L Untitled

E| Connections
: == Enst
== Main_part

Edit
Remove

Conversio

@ Camplete

Remove Al
Online
Compare MCT Tables

Figure 9- Adding a new configuration

After the user adds a configuration, the TagList will open a window
should choose the file which contains the desired configuration.

(Figure 10) where the user

Choose Configuration 21x|
Look in: IEWDrking j ~ cF B
=
|38] LEDDS @
teste
File name: |LEDO8 V8 = geen |
Files of types: | Configuration [*.PL7; * PLE) | Cancel |
™ Open as (ead-only
A

Figure 10- Locating the configuration to be added

directories.

The user will not be able to include duplicate configuration names, even if in different sub-

Next the TagList will open a window for the user to configure a few parameters regarding the
chosen configuration. This configuration is present in the LC700 memory, so a reference is made to

the device.
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Note:

The Block View and
Digital Block
features are only
available for Smar
devices.

Redundancy:

Just enable the
Redundant Enabled
and inform which
one is the redundant
channel/port.

x
v Device Enabled Device D l 1
v Uze BlockMiew [+ Use Digital Block

Device Tag:
|LEDDS_vE

Drirectary:
IE: “Program FileshSmaryCONF7O0_+8_5ENWorking', ___l

Canfig. Mame;
|LEDO3_wEPLE

t ain Cormm Port [MCF]
IMain_pu:urt ;I

Fredundant Carmrn Port [RCP)
Fedundant por LI

v Redundant Part Enabled

ok I Cancel |

Figure 11- Device Configuration

In the window above (Figure 11) the user must configure a few parameters regarding configuration
and the recently added device.

- Device Enabled: Enables/disables the device. In case this parameter is not selected, the OPC
Server will not monitor it.

- Device ID: Device address in the MODBUS network.

- Use Block View: Enabling this parameter the user can compact the commands of the OPC
Server, increasing communication speed.

- Use Digital Block: Enabling this parameter the user can read all digital points using only one
command of the OPC Server, increasing communication speed.

- Redundant Enabled: Enabling this parameter, the user will have enabled the redundant
channel.

The Redundant Enable ICON is displayed as (In GREEN) : ﬁé when it is enabled.

Redundant Disabled ICON is displayed as (In RED) : ﬁé when it is disabled.

- Main Comm Port: the user should inform which port previously configured will be the main
channel.

- Redundant Comm Port: In case redundancy is used, the user should inform which configured
port will be used as redundant channel.

- Directory: Directory where the added configuration is located. Clicking in _I is possible
change this directory. This procedure is useful when the configurations (.tag and .pl8) are
transferred from any computer to another.

- Configuration Name: Name of the configuration associated as a device (for example, LC700).

- Device Tag: Is the Tag in which the device is referred by the OPC Server

After the ports are added and configured, the user should view a screen similar to the following
picture. Two ports were included, a main serial port, a redundant port, through an Ethernet port.
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File Edit ©PC Help

O e @E@

L3 Unitted

- Connections

== Enet

== Main_part

== Redundant_part
=] %: Device List

Carwersions
"B Complete Tag List

LED ACF: Main_port] [RCF: Redundant_por|

Device Enabled Port Name Device ID Device Name Usze Block Wiew Fedund:
» [l 1 ain_port 1 LEDDA_v& [cal |

Figure 12 - OPC Connection through a Serial Port/Ethernet port configured via TagList

Editing/Removing a Configuration / Device

Saving the Project

The OPC Menu

To edit or remove a configuration, it is necessary to select the configuration on the main screen.
Right click it, the edit/remove configuration dialog will appear, then just change the desired settings
and click on OK for the changes to take place, or click on the Remove to remove the configuration.

To compile the project (to generate the Tag List) it is necessary, first, to save the current project.

To save the project using the menu, click on File, then Save (if the project has already a name) or
Save As (if a new you wish to save the project with a new name), or on the icon Save (windows
standard) on the toolbar.

The OPC Menu has the following options:

- OPC Monitor
- Show Active TagList
- Register Active TagList

_. TagList ¥& for the LC700 OPC 2.0 Server ¥8.54 - [Led08_v8.TAG]

File Edit | opC Help

D D"' CPC Monikar

] Ledis Show Active Tag Lisk Device

E|-- Col Reqister Active Tag List

:H: ETIET

- Main_part

i e Redundant_port
E%: Device List

R 1L ED03 5 [MCP: Main_port] [RCP: Redundant_per
- Conversions

[E Complete Tag List

Figure 13- Accessing the OPC Menu

Registering the Project
After the project name is chosen, it should be registered in Windows, in order for the reading
software of the LC700 OPC Server to recognize which configuration to search for. So every time a

new project or project name is changed, it should be registered, to be indicated as the current
project.

To register a project, click on the OPC menu and on Register Tag List. Or click on Register
Configuration, on the Toolbar, as shown in the next figure.
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Note

Each change done
in the configuration
in the CONF700, a
new TaglList Table
must be generated.
The user needs to
open the current
TagList project and
execute the
command to
generate the TagList
Table again.

File Edit OPC Help
03 HeCo@E @

Fig 14- Registering the current TagList

Generating the TagList Table

The program will generate the points monitored by the LC700 OPC Server. The Tag List Table
associates the address/Tag in the LC700 with the name/Tag given to it by the OPC server.

While the tag List is being generated, the “Tag OPC” (name of the LC700 point that will appear for
the user on the OPC client) is assembled as follows:

- If the user defined a User Label on the CONF700 for the point, then this will be defined as a
name for the Tag OPC of the point.

- If the user did not define a User Label, then the Tag OPC will be the point’'s Default Label.

To generate the TagList Table, click on OPC and then Register Tag List, or click on the option
Register Tag List on the Toolbar.

File Edit OPC Help
D= da <« @@

Q, Led08_ w8 Device Enabled Port Mame Device ID
#-El Cannections
- %: Device List

-3 LEDOS_v8 [MCP: Main_port] [RCP: Redundant_por
Conversions

C:A\Program FileghSmarkTaglist and LCF00 OFC Server
w8 BN orkingtLed08 8. TAG

oK I Cancel

Reqgistry updated

Figure 15- Generating the TagList Table

After the project registration and the Tag List generation, the system is ready to monitor the LC700
points using the LC700 OPC Server. So, the Tag List program can be closed. The operational
system automatically locates the current configuration for the LC700 OPC Server when activated by
a HMI Software (OPC Client).

10
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Verifying the Active Tag List table

In case the user wishes to check which Tag List Project is registered on the computer, click on the
OPC menu, then click on Show Active Tag List, then the program will show which is the active Tag

List.

Viewing the Tag List Table

The user can check the table generated by the Tag List. In order to make it, click on (+) of the added
configuration, two options are available: Tag List and MCT.

Tag List

The figure below shows the Tag List table generated for the current configuration.

File Edit ©OPC Help

0D Ha v @

L3 Ledln_v
- Connections

4 Main_port
Device List

Corwersions

~= Redundant_port

=y LEDOB_vB

Complete Tag List

Tag Address Conversion Type Description
> SAIDA 0ooat <Naonex BOOL ledd
M-122G1B40003.1 oooo2 <None> BOOL led1
M-122G1B40003.2 00003 <MNone: BOOL led2
M-122G1B840003.3 00004 <None: BOOL led3
M-122G2840003.4 00005 <MNone: BOOL lexdd
[MCP: Main_port] [REP: Redundant_por M-122G2B40003.5 00006 <Nane> BOOL  |ledS
t M-122G2B40003.6 00007 <MNonex BOOL ledf
M-122G2840003.7 0ooog <Naonex BOOL led?
WMIBG1T11.0 02001 <MNaone> BOOL
WMI1BG1T111.1 02002 <None: BOOL
WMIBG1T11.2 02003 <None: BOOL
WMIBG1T11.3 02004 <None: BOOL
WMIBG1T11.4 02005 <MNone: BOOL
YMI1BG1T11.5 02006 <Nonex BOOL
YMI1BG1T11.6 02007 <Naonex BOOL
WMIBG1T11.7 02008 <Naone> BOOL
TEMPO 02003 <MNone: BOOL
TEMP1 02010 <None: BOOL
TEMPZ 02011 <MNone: BOOL
TEMP3 02012 <None: BOOL
TEMP4 02013 <None: BOOL
TEMPS 02014 <Nonex BOOL
TEMPE 02015 <MNaone> BOOL
TEMP? 02016 <None> BOOL
MADUSADD 02017 <MNonex BOOL Entrada ENO ndo utlizada por bloco de fur
FaLs0 02018 <None: BOOL Entrada
WMIBG1T1I3.2 02013 <MNone: BOOL
YMI1BG1T1I3.3 02020 <None: BOOL
WMI1BG1T113.4 02021 <MNonex BOOL
YMI1BG1T113.5 02022 <Nonex BOOL
YMIBG1T1I3.6 02023 <MNaone> BOOL
WMIBGIT1I3.7 02024 <None: BOOL
EMNTRADA 1 1000 <MNone: BOOL
ENTRADA 2 10002 <None: BOOL
M-020G1B8I002.2 10003 <MNone: BOOL
M-020G1B8I002.3 10004 <Nonex BOOL
M-020G1B8I002.4 10005 <Naonex BOOL

Figure 16- Viewing the Tag List table

In the above table, it can be seen:

Tag: configuration point names.

Address: Modbus addresses of the configuration points.

Conversion: filed to convert the data types.

Type: data type.

Description: description done in the CONF700 through the Global Table (it can be done also in
the Tag List).

MCT

In

this option the user can choose which points will be monitored by the device that uses the

Modbus protocol. Clicking on (+) at left of MCT, two folders will be showed:

Working
Device

Discrete Outputs
(0x)

Discrete Inputs
(1x)

Analog Inputs
(3x)

Analog Outputs

Type (4x)

N° of
points

250 points 250 points 250 points 500 points

11
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Working

Clicking on this folder, four Address Ranges will be open. This folder becomes available the points

which are done download.

- Ox - Digital Outputs and Virtual Points.
- 1x-— Digital Inputs.

- 3x—Analog Inputs.

- 4x— Analog Outputs, Function Blocks and Special Registers.

Device

Clicking on this folder, four Address Ranges will become available to visualize the configuration

points.

- Ox — Digital Outputs and Virtual Points.
- 1x - Digital Inputs.

- 3x—Analog Inputs.

- 4x— Analog Outputs, Function Blocks and Special Registers.

File Edit ©PC Help

O By @@

[—]%: Device List
=i LEC08_vE [MCP: Main_pon] [RCP: Redundant_por
[El Tag List
=R HCT|
IE Wworking
[El Device
----- Conversions
----- (Bl Complete Tag List

Q Led08_w8 Device Enabled Part kame

=-EL Connections hh: haMi
:H: Enet
:H: M ain_port

Figure 17- MCT Option

Using the MCT

When one of the address ranges is selected in the Working folder, a table at left of the Address
table appears. In this table the addresses are added which must be configured. Four buttons also

appear below the screen to do the Tag List table.

Button ‘ Description
:I LI Move the Tags between the lines up and down
Remove Tag Remove Tag from the table
Add Cell Add lines in the table
Add All Cells Add the whole table at once
Delete Cell Delete lines

12
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File Edit OPC Help

O e ke

8 | ed0s w2

-8 Conrections
= Enet

= Main_part

[=-#a Device List

[ET) Tag List
= (B MCT

(B
[B] Device
Conversions
--[BI] Complete Tag List

= Redundant_poart

- LEDOR_ 8 [MCP: Main_port] [ACP: Redundant_par

EI B Wwarking

L3

| Tag I MCT | Address Tag Address | MCT Conversion Description
] [ 0700 | p | FALS0 [ENEIE <Nanes Entrada

M-122G1B40003 00002 0 <MNone> led1
M-122G1B40003| 00003 |0 <Moner ledz
M-122G1E40003 00004 0 <Monex ledz
M-122G2E40003| 00008 |0 <Mone: ledd
M-122G2E40003 00008 O <Monex leds
M-122G2B40003| 00007 |0 <Mone> ledf
M-122G2B40003 00008 O <Mone> led?
Madusano 02017 |0 <Maones Entrada ENO n&o utlizada p
SAIDA T ooom o <Mones ledd
TEMPO 0009 (o <Mones
TEMP1 02010 0 <Mones
TEMPZ o0z011 (o <Mones
TEMP3 02z o <MNones
TEMP4 0zms (o <Mone:
TEMPS 02014 0 <MNone>
TEMPE oz2ms (o <Moner
TEMP? 02me o <MNone>
WMTBGITTA.0 (02001 |0 <Mone:
WMIBGITIN 02002 0 <Monex
WMIBGITTN.2 |02003 |0 <Mone:
WMIBGIT1M.2 02004 O <Mone>
WMTBGITT.4 |02008 |0 <Mone>
WMIBGITIN.S 02006 O <Mone>

hd YMIBGITTN.E |02007 |0 <Mones

Il

r's | - | Remove Tag Add Cell
Add Al Cells Delete Cel

Figure 18- MCT Option

Description of the Address Table Columns

Tag: Name of the point
Address: Point Address

MCT: Counter of how many times the Tag was added in the MCT table

Conversion: Allows scale conversion
Description: Point description

Configuring the MCT table
To configure the MCT table, follow the steps:

1)

Click on the Add Cell button.

One line will be added in the table.

13
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|Tag |MEIT |Address - Tag Address | MCT | Conversion Description
> [ o700 | y [ FaLso nzme |0 <Monex Entrada

e O KL
O O
zszonlowo o aers |
_ Entrada EMO ndo utlizada ¢
o) —oas oo
I O

WMTEGTTI1.0 02000 _
YM1BG1TI.2 | 02003 _
WMTBGITII1.4 | 02005 _

WMIBGITI.E | 02007
. S KT
! ! Remove Tag | Add Cell |
Add All Cells | Delete Cell |

Figure 19- Configuring the MCT table

2) Click with the left button on the point which will be added in the table.

| Tag | MCT | Address * Tag Address | MCT | Conveersion D escription
] [ 0700 FaL50 neme [0 <Nones Entrada

#-122G1B 40003 | 00003 _
14-122G2B40003 | 00005 _
1122628 40003 | 00007 _

e __oars 0 _Jaere |
I O
e Joars o _aere |
rows__oars o _Jaere |
povceinne Joan o _aers |
owesiinz Joass o _Jawe |
oncein« Joare o _Jare |

- VM1BGTT11.6 -
. el |

! ! Remaove Tag Add Cell |
Add All Cells Delete Cell |

Figure 20- Selecting the points for the Tag table
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3) Click with the right button on the line and drop to the added cell.

I MCT I Address * Tag Address | MCT | Conversion Description *
Ju] | o7 |02y FALSO nz012 <Mone Entrada

1-122G1B 40003 | 00002 <Mone ledl
M-122G1B 40003 | 00003 <Mone led2
M-122G1B40003 | 00004 <Mone led3
122G 2B 40003 | 00005 <Mone ledd
M-122G2B 40003 | 00006 <Mone led5
122G 2B 40003 | 00007 <Mone ledE

<Mone led?

W-122G28 40003 00002

- Entrada EMO
SaiDa 1 00oo

I

1]

1]

1]

1]

1]

1]

1]

1]

1

1} <Mone: ledd
TEMFO nzo03 1} <Mone:
TEMP1 02010 1} <Mone:
TEMPZ 02011 1} <Mone:
TEMP3 02012 1} <Mone:
TEMP4 02013 a <Mone:
TEMPS o204 0 <Maore>
TEMPE nzos |0 <Maone:
TEMF? 2016 |0 <Maore>
WM1BGITIM.0 | 02001 1] <Maone:
WM1BGITIM.1 (02002 O <Maore>
WM1BGITIM.2 | 02003 |0 <Mones
YWM1BGIT1.3 | 02004 O <Mone>
WM1BGIT1M.4 | 02005 |0 <Mones
WM1BGIT1M.5 (02006 O <Mone>

2 WM1BGITIN.G | 02007 |0 <Maone: @
4 S EN »
:I LI Femove Tag | Add Cell |
AddAlCels | Dete Cell |

Figure 21- Adding points in the Tag table

4) Repeat the steps above to add all the points which must be monitored.

The TagList configuration must be the same which is running in the LC700.

The user can upload the configuration points without do the download previously, in order to check
the LC700 configured points. If the configurations have the same name, it is impossible.

Consistency Check
If any point is configured in the MCT Table, in the Working folder, and it is not in the Total Point
Table, its address will be red.

If any address in the MCT Table, in the Device folder, is red, it means this address is not in the
configuration that is running in the CPU-700.

Download to the Device

To configure the MCT Table, it is necessary to do the download of the added points. In order to
make it, click with the right button on each one of the address ranges in the Working folder. A popup
menu will be opened, select the Download to Device option. Or click on the toolbar Edit >
Download to Device. See the following picture:

15
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#-E Connections

EI%: Device List

=@y LEDDE_va [MCP:
(Bl Tag List
=-(Bi] MCT

=B Working

b ain_port] [RCP: Redundant_por

add

Edit
Remave
Rermove Al

Download To Device

Compare MCT Tables

Figure 22- Doing the Download to Device

After doing the download of the all points that were added in the MCT Tag Table, a message about

the Successful Download will appear.

[ TagList ¥8 for the LC700 OPC 2.0 Se|

i Download to Devic

Ix

File Edit OPC Help ¥ Use Device Connection
LY
D = & 2 |%% Device D |-|
L) Mova configuragio  Interface - Tag Adc
Connections &+ Serial ﬂl FALSD 020
£ & Devics Lis o I M-12261B40003 000
=1 LEDOS_v& [MCP: Main_por] [RC ' L N M-12251B40003] 000
[E Taqg List Baud R ate: I 9500 vl E M-122G1E40003 | 000
e 0p LOOKINg
=] @ MCT . Fiary TVEN = —I -122G2E40003 | 000
- Working M-122G2640003 | 000
N (B1] = RTSACTS Timeout: |D 12262840003 | 000
""" :13“ (0=Disable RTS/CTS) 152840003 -
..... " NADLIGAD
(B 4 € TERAR S4DA 1 00n
=B Device IP &ddress I I I I TEMFD 020
..... s TEMPT 020
..... &) 1x TEMF2 020
..... (Bi) 3« Additional Time out: 500 TEMF3 020
..... 4 . TEMP4 020
. Murber of Fetries: |2 |
EDnVTmC‘;S L = pmmunication Status ll F5 020
SISl r Device Information Eg g;g
Device: LC700/14.54.65 @ MCT Dowenioad Successfl. 710 |20
. . EG1T11.1 | 020
- LEDDB_+8
St o - BG1T111.2 | 020
Yersion: 14.54.85 EG1T111.2 020
G1T11.4 |020
®Run ®Foce OHold @ Faul SRS (R
WMIEGTTIN.E | 020
| YMIRRITIA 7 N0

Figure 23- MCT Download Successful

The Upload function can not be done successful if the TagList and LC700 configuration is not the
same.

Upload from Device

After all points of the MCT Tags Table have been sent to device, the upload of these points must be
done in order to compare them. In order to make it, click with the right button on the Address ranges
in the Device folder, a popup menu will be open, choose Upload from Device. Or click on the toolbar

Edit > Upload from Device.

16
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mTagList w8 for the LC700 DPC 2| s Upload from x|

File Edit OPC  Help [¥  UseDevice Connection

O -:' | Sy @ Device D |1

O Nova configuragio - Interface: ol I - Tag Address
Connections & Ceral —Iose |_ b |VMIBGITII37 02024

-3y Device List Port | = YMIBGIT3E | 02023

£ LEDOE_+8 [MCP: Main_pol —|°° YMIBGITIEE | 02022
Baud Rate: EEI | —p—— YMIBGIT1I34 | 02021
Pariy | _Stop Losking| YMIBGITI33 | 02020

YMIBEIT1I32 | 02019
RVSEIS M=z | ] YMIBGIT1M 7 | 02008
[0=Disable RTS/CTS) YMIBGITIIE | 02007

 TCRAP YMIBGITIITE | 02005

WMIBGIT1M.4 | 02005
IPAddressl | | I WRMIBGIT1M. 2 [ 02004
WMIBGIT1N.2 | 02003
WRIBGITIA.1 (02002

Additional Tirne out: B0 YMIBGITIA.O | 02001
o (E] 4 Nurnber of Retries: I TEMP? 02016
X 4 2 -
Canversians TEMFE 02015
(B Complete Tag List SR e Communication Status x| 02014
' 02013
Device LE700A1454.65 R
@ Upload Successful, MCT Enabled. e
Configuration;  LEDO3_v3 o200
Wersian: 14.54.85 TR
0ono1

® Run @ Force  rrrom—wrren on nam s
I 12262840003 | 00008
I M-122G2840003 | 00007

Figure 24- Upload Successful

Do the Upload for all Addresses ranges.

Comparing the Tag Tables

Finishing the Upload for all points, it is possible to compare the Working and Device Tables. Click
with the right button on one of the address ranges in the Working or Device folder, a popup menu
will be opened, choose the Compare MCT Tables option, or do this clicking on the toolbar Edit >
Compare MCT Tables.

. Compare MCT Tables - |EI|5|
‘working MCT Table Device MCT Table
MCT Address Qriginal Address Comment Tag MCT Address Original Address Comment
16001 10001 Ok B |EHTRADA 1 16007 10007 Ok,
16002 10002 Ok ENTRADAZ | 16002 10002 Ok

Replace Claze

Figure 25- Comparing the Tag Tables

It can observe:

- OK: The Device and Working original addresses are the same.

- Tag Mismatch: The Device and Working original addresses are different.

- Not found in Device: the original address was in Working was not found in Device.

There are also two buttons on the right lower corner:
- Replace: replace all points from the Device table to Working table.
- Close: close the active window.

17



Tag List Generator — User’s Manual

Conversions

For each Tag, the user can select if this Tag Value will have Conversion from Device Range to
Engineering Units, or Not. First the USER needs to create a "Conversion Type" that will apply for a
Tag Value. After having created a Conversion Type, the USER needs to assign this Conversion to a
Tag, or assign to a group of Tags, that use the same conversion type.

When the OPC reads the value from the Device, it will convert this value using the conversion rules
created, and provide the converted value to the OPC Client.

Only Tags with DATA TYPES: WORD, DWORD, INT, and REAL, are allowed to have
CONVERSION, the Other DATA TYPES are NOT allowed. Only Tags that can be represented in
Eng. Units (EU) can be converted.

The Tags with DATA TYPE: BOOL and BYTE do not allow conversion to EU.

Filz Edit OPC Help

D e e

@ Leddd w3 Carw Marme Coree Type Lows ELI
" Cannections 3 Corversio Linea] |- il
=-%a Device List #* Conv Typs
: Elffﬁﬁ LEDDS_+8 [MCF: Main_port] [RCF: Redundant_par Float
@ Tl [
=Bl MCT

Wwiorking
: (B Device
[#-4=y Conversions

Figure 26- Conversions

Type of conversion
There are three types of Conversion:
Floating Point Conversion

If the USER checks the Option: “Floating Point Conversion”, the OPC Server will convert the data
into float data type, but will not change the value itself.

Linear Conversion

The OPC Server will use linear conversion between EU and Device scale, if the option: “Linear
Conversion” is checked.

There are two types of units:

EU Engineering Unit (client scale)
Device Device range (device scale)

Square Root Conversion

This conversion performs the following operations:

Ri =Y = (Y —yD) */(y2-yD)

(HighEU — LowEU ) * (Ri — y1)
(y2-yl)

Rf = LowEU +

18
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Where:

Ri: Intermediate Result

Rf: Final Result after the linear conversion
Y: Tag value

y1: Value defined for Low Device

y2: Value defined for High Device

For this conversion, there is the Cut Off parameter. When the Tag value (Y) is lower than the value
defined for Cut Off, the result of the conversion is zero. When the Tag value is higher or equals to,
the result of the conversion is obtained according to the equations showed above. The linear
conversion is applied to the obtained result, considering the values defined in High Device, Low
Device, High EU and Low EU.

If Y < Cut Off
Then Ri=0
Rf < LowEU J{(nghEU — LowEU ) * (Ri — yl)}
(y2-yl)
If Y 2 Cut Off

Then Ri =Y = /(Y —y1) */(y2- y1)

Rf < LowEU J{(nghEU — LowEU ) * (Ri — yl)}

(y2-yJ)

Example:

For the Square Root conversion, it considers the values below:
Low Device: 0

High Device: 10000

Low EU: 10

High EU: 50

Cut Off: 10

It has the following results according to the tag values showed below, and the equations presented
above:

Y Ri Rf
(Tag value) (Intemediate result) (in Engineering Unit)
331.6625 11.3267
10 316.2278 11.2649
9 0* 10
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i Edit Conversion X|

Mame  |Corvers3d

— Conversion
™ Flaating Point Conversion

i~ Linear Conversion ¥ Sguare Root

Cut OFf | 10

Law Device I g LowEU I 10
High Device .

| 10000 High EU | 50

— Clampinig

[ Clamp Low Clamp I 5
HighClamp [ 15

] | Cancel

Figure 27- Conversion Types

If the “Clamp” option is selected, the data value will be limited by High Clamp and Low Clamp. The
Clamp occurs after the conversion.

After setting a conversion type, the user can set the conversion for the specific TAG directly in the
Device Tag List. Just choose the TAG, and in the conversion FIELD, click at it and choose the type
of conversion in a drop down list as the following picture shows:

Tag Address Conversion Type Dezcrphion
TOMT.CTA 42520 <Mone: INT
TOMTPST 42521 <Mone: INT
TOM1.5TS 42522 <Mones: WORD
TOMT.CTA 42523 <Mone: INT
TOMT.PST 42524 <Mone: INT
TFP1.5TS 42525 <Mone: WORD
TP1.CTA 42526 <Mones INT
TF1.PST 42027 <Mone: INT

b TP3STS 42529 <Mones | WORD
TP3LTA 42530 Conw Mame |~ INT
TP3APST 42531 INT
TP45TS 42532 Conversio = wWORD
TPA.CTA 42533 <Mone: INT
TP4.PST 42534 <Mone: INT
TPR.STS 42535 <Mones: WORD
TPE.CTA 42536 <Mone: INT
TPE.PST 42037 <Mones: INT
TPESTS 42538 <Mone: WORD
TPECTA 42539 <Mone: INT
TPE.PST 42040 <Mone: INT
TP?.5TS 42541 <Mones: WORD

Figure 28-Using The Conversion
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Status provided by the LC700 OPC Server

After generating the Tag List table, the OPC Client (an HMI interface for example) can read the
variables referred by the Tags. Also, the OPC Server provides some status which contains
additional information.

B Status_Port.<Configured Port Tag >
- CommlD: A number is attributed to the configured port by the TagList.
- CommPortStatus: Shows the status on the port.
1 - Normal Communication on the port.
0 - Communication failure on the port.
- ActualScan: It is the period the LC700 OPC Server takes to read all devices connected to the
configured port.
- ScanPeriod: It is the value of the Scan Period parameter configured for the port.
- RetryPeriod: It is the value of the Retry Period parameter configured for the port.
- Timeout: It is the value of the Timeout parameter configured for the port.
- Retries: It is the value of the Retries parameter configured for the port.

B Status_Device.<Device Tag containing the configuration>
- MainPortStatus: Indicates the main path’s communication status for the device.
1 - Communication without problems
0 - Failure on the main channel
- RednPortStatus: Indicates the redundant path’s communication status for the device.
1 - Communication without problems
0 - Failure on the Redundant channel
- UseBlockView: Indicates if the user has configured the "Block View" option.
0 - the user disabled this option
1 - the user enabled this option
- UseDigitalBlock: Indicates if the user has configured the “Digital Block” option.
0 - the user disabled this option
1 - the user enabled this option
- MainPortID: Indicates the main port number where the device is connected. This value is equal
to CommlID for the specified port.
- RednPortID: Indicates the redundant port number where the equipment is connected. This
value equals to CommiID for the specified port.
- ActivePort: Indicates which path is active.
0 - the Main Path is active
1 - the Redundant Path is active
2 - no path is being used or reading failure
- Enabled: Indicates if the user has enabled or not the device.
- MainScaninterval: Indicates the real time interval between cyclic readings of all Tags/variables
from the current device, through the main path.
- RednScanlnterval: Indicates the real time interval between cyclic readings of all Tags/variables
from the current device, through the redundant path.
- MainActualScan: it indicates the real time taken to read all tags/variables from the current
device, through the main path.
- RednActualScan: it indicates the real time taken to read all tags/variables from the current
device, through the redundant path.
- NbrCommCmmd: it indicates the number of Modbus commands that the OPC Server is
sending in order to supervise the requested points.
- ViewStatus: Indicates the current status of the Block View current used by the OPC for
scanning the device. The status composition is as follows:
e ViewStatusOx:
0 = Block View not being used
1 = Block View is being used
> 1 = Error on view assembly or view is still being assembled by the OPC.

Where ViewStatusOx:

e ViewStatusO1 - Block View Status 01
ViewStatus02 - Block View Status 02
ViewStatus03 - Block View Status 03
ViewStatus04 - Block View Status 04
ViewStatusO1 - Block View Status 05
ViewStatus02 - Block View Status 06
ViewStatus03 - Block View Status 07
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e ViewStatus04 - Block View Status 08

If the ViewStatus value is greater than 1, an error occurred on the assembly or ViewStatus is still
being assembled. The value is a BIT combination, and to know what the status means, the
configured BIT should be known according to the table below:

Block View Status
BIT | DESCRIPTION | VALUE(DEC) | COMMENTS

0 Block View OK 1 If the block view is OK the other Bits should be zero.

1 NEED ASSEMBLY 2 \C/)ilzvcv has received a new configuration, and will assemble a new Block

2 IS ASSEMBLING 4 OPC Server is assembling the Block View.

3 USE COMMAND LIST 8 An error has occurred during the assembly. OPC is using MODBUS
commands.
Failure on Block View assembly — CONFIGURATION ERROR
(Response Code 07(hex)). A possible cause would be an inexistent

4 ASBL RSP CNF FAIL 16 Modbus point. In this case the OPC Server is using individual
commands.
Failure on Block View Assembly - BLOCK VIEW IS FULL (Response
Code 0B(hex)) A possible cause would be that there are other Modbus
Masters (other servers for example) accessing the same slave device

5 ASBL RSP BVW FAIL 32 using view. In this case the OPC Server is using MODBUS command
standards and as soon as one of the views is available, it will be read by
VIEW.

6 | ----m-
Failure on Block View assembly- (communication failure) — This BIT will

7 | ASSEMBLY FAIL 128 be 1, when the bits 4 and 5 fail

The OPC Monitor Software

The TagList has a software that helps the configuration test and can be used to monitor points using
the LC700 OPC Server, and check for errors in the configuration. It is the OPC Monitor. It is
accessed through the OPC menu (see figure 12). Just access the menu OPC-> OPC Monitor.

The OPC Monitor is an OPC client that can work with any OPC Server. In case of LC700 OPC
Server monitoring, it allows the user to view the values of the Configured variables/Tags and the
status described on the previous item.

In case the LC700 OPC Server is used, initially the OPC Monitor will show the screen below, which
the user should choose the Server Smar.LC700Server.1.

Smar LC700 OPC Clhient

OFC Server List:

SmarlSererl
Smar.DFEBServer.

Smar.LC ver. 1
Smar.Dfi0leServer.0
Smar. hzeoleserver.0

Servertame
ISmar.LE?DDS erver.

Connect | Cloze |

Figure 29- Choosing the OPC server for the OPC Monitor
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Right after, the OPC Monitor automatically opens the screen shown in the next figure.

-] StatusPort_SeralR5232 | Tag ‘\u"alua |T_upa |Quality |Nhr Of Failz ‘ Time |Llser Tag | Desc
-] StatusPort_Enet
m{j StatuzDevice_OPC
(] OPC

Figure 30- The OPC Monitor

On the column on the left, there are (in this order): the channel status, device status and
variables/Tags values. Note that the devices have a specific MODBUS ID and this order must be
respected. Clicking on each item, they are expanded in sub-items. For further details see the
previous item “Status provided by LC700 OPC Server”.

With a left click on the mouse button, the user can select which status, and which variable to
monitor. The screen below shows a few selected status. To remove some status from the monitor
page, just double-click the status or variable in the screen on the left.

TagList ¥6 for the LC700 OPC 2.0 Server ¥8.55 - [Monitoring OPC ¥alues] - Smar.LC7005erver.1 =101 x|
-|=) TPT.5TS ;I Tag |Add|ess |Va|ue. |Typa |Qua|ity |Nb[DfF‘ai\s |T\me |Dasc |Us'erTag ‘Default Tag
12 TPTICT LEDO8_v8.DIG_OUTI.0 0BooL | ! | lledd  [DIGOUTLO M- 0003.0
-2 TP7PST LEDO8_vB.YMIBGTT1N26.0 0BooL | | | - |
[ TPaSTS LEDOB WBTOTAL MNT ! I {TOTAL
[ TPRICT |
- [E] TPEPST
[E1 TONBSTS
[E) TOMgICT
-[E] TONBPST

|1 INT_CHST.PRM1
-2 INT_CNST_PRM2
-1 INT_CNST PRM3
-[E INTC
-[EINTE_2
-[E1INTE_3

] 014

[£) REALCT1.PRMT
-[2] REALCT1.PRM2
-|2] REALCT1.PRM3
- [Z1 REALCT1.0.1
-2 REALCT1.0.2
-2 REALCT1.0.3
-[Z] RTC Sec
-[E1 RTC_Min

=] RTC_Howr

[Z) RTC_Dweek

- [E) ATC_Day
21 AT Man =l RiN i

Add to Grid | Clear Grid | Clear Fail Count | Tags Monitored: 3 | 1000 Sean Time [mihlse_co'pds] Close |

Start Manitaring

Figure 31- Viewing Status and Tags

The configurations are right below, and can be expanded. The user can choose which variables to
monitor directly through this variable’s Tag, without worrying about the MODBUS addresses. The
OPC Monitor has some buttons on the lower screen. The “Start Monitoring” button starts the
monitoring. “Add to Grid” means that the user can select only one tag or a group with tags (to select
the initial tag uses Ctrl + left button of the mouse or just left-click, and to select the ending tag of the
range uses Shift+ left button of the mouse) and then clicks in this button to add in the grid the tags
will be monitored. “Clear Grid” erases the status selection and variables previously made. “Clear Fail
Count” is used during monitoring to erase the failure messages on the communication. The “Close”
button ends the program.
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TagList ¥8 for the LC700 OPC 2.0 Server ¥8.55 - [Monitoring DPE ¥alues] - Smar.LC7005erver.1 o [ 4
File
] StatusPort_SeralRS232 o |Tag [Addiess [Walue |Tupe  [uality [Non Of Fails [Time [Desc [User Tag | Default Tag
-2 CommiD StatusPorl_SeralRS232 ScanPeriod 0 |
-[E) CommPortS tatus LED08_v8.0IG_IN.0 10007 0 BOOL conirol start DIG_IN.D M-020G1BBI002.0
- Actualscan LEDOS v8.DIG_IN.1 10002 G key 1 DIG_IN1 | M-0ZDETBEI00Z 1
-2 SoanPeriod LED08_vA.0IG_IN.2 10003 0 BOOL key 2 DIG_IN.2 M-020G1BBI002.2
[ StatusDevice_LEDOS v& LEDOS_v8.0IG_IN.3 10004 0 E0OL key 3 DIG_IN3 | M-0ZDETBEI00Z 3
-[E) MainPanStatus LEDO2 v8.0IG_IN.4 10005 LR key & DIG_IN.4 M-020G1B81002.4
[5) RednPortStatus LEDOS_v8.0IG_IN.5 10008 0 E00L key 5 DIG_INE | M-0ZDE1BEI00E 5
-2 UseBlockyiew LEDO2 v8.0IG_INE 10007 LR key € DIG_INE M-020G1B8I002.6
[5) UseDigitalBlock. LEDO8_vA.0IG_IN.7 10008 0 BooL key 7 DIG_IN7 |M-020G1B81002.7
- MainPaniD LEDO8 v8INTC_1 42560 0/INT INTC_1 |OUTTICT 7
5] RednPorD LED08_vA.INTE_2 42561 0INT INTC_2 |ouT2ICT A
-2 ActivePort LEDO8 v8INTC_3 42562 0/INT INTC_3 |OUT3ICT 7
-[2) Enabled LED0&_v8.TOTAL 42563 0INT TOTAL OUT.ADD.1
[5) MainSeanCycle LEDOS_v8RTC_Sec 43551 0/ WORD | Seconds [RTC) RTC_Sec  RTC Sec
-[B) RednScanCycle LEDO8_v8.RTC_Min 43352 0WORD Minutes [RTC) RTC_Min RTC_Min
[E) MbiCammCrnd LEDOS_v8RTC_Hour 43553 0/WORD | Hour [RTE] RTC_How  RTC_How
-3 ViewStatus01 LEDDB vB.RTC Dweek 43954 0 WORD Dap-ofweek [RTC] RTC_Dweek | RTC_Dweek
[2) ViewStalus02 LED08_vA.ATC_Day 43355 0WORD | Day [ATC] RTC_Day RTC_Day
-3 ViewStatus03 LEDO8 w8.ATC_Mon 43956 0/ WORD Manth (RTC] RTC_Men RTC_Men
[2) ViewStalusD4 LED08_ vA.RTC Year 43357 0WORD | Year (ATC) RTC_Year  RATC_Vear
-3 ViewStatuss LEDD8_+8ScanCycleTime 43958 0 WORD | LC700 CPU Scan Cycle fin ScanCycleTime | ScanCycleTime
-2 ViewStalusDR LED08_v8.TEMFD 02001 0 BOOL first light TEMPD WMIBGTTIIT.0
) ViewStatus07 LEDOB_vB.TEMF1 02002 0BOOL | seoond light TEMP1 [WMIBGITIN.1
-2 ViewStalusDg LED0&_v8.TEMP2 02003 0 BOOL third light TEMP2 WMIBGTTIIT.2
(1 LEDDS v8 LEDOS_v8.TEMF3 02004 0/BOOL | faurth light TEMF3 |WMIBGITIN.3
-E DIG_OUT.0 LEDOS 8. TEMP4 02005 LR ffth light TEMP4 WMIBGTTIT.4
2 DIG_0UT11 LED0S_v8.TEMPS 02006 0pooL | sisth light TEMPS |WMIBGITIN.G
-E DIG_0UT1.2 LEDO 8. TEMPE 02007 LR seventh light TEMPE WMIBGTTIIT6
=) LEDOB_vE.DIG_0UT1.3 00004 0pooL | led3 DIG_OUTL3 | M-122G1B400033
-2 DIG_0UT2.4
-E) DIG_0UT25
- DIG_OUT25
-2 pia_out27
3 TEMPD =l 0

SlartMDmIDringl Add to Giid | Clear Grid | Clear Fail Count | Tags Monitored: 29 7000 Sean Time (millseconds] Closa

Figure 32- Adding and removing status and variables

To start the monitoring, click on “Start Monitoring”. To end the monitoring, click on “Stop Monitoring”.

TagList 8 for the LCT00 OPC 2.0 Server ¥8.55 - [Moni DPC Yalues] - Smar.LC700Server.1 = |EI|5|

Eile

Tag |Address [Value  [Type  [Qualy  [MbrOfFaike | Time |Desc | User Tag | Defaul Tag
StatusPort_Serial-R5232.5 canPeriod | 1000 Good | 0/ 74355 PM

LEDOS_vB.DIG_IM.0 10001 0 BOOL | Good 0/1:3451 PM | caontral start DIG_IN.O M-020G1BBI002.0
LEDOS_wB.DIG_IM.1 10002 0 BOOL | Good 01:34:51 PM key 1 DIG_IN1 M-020G1BBI002.1
LEDDZ vB.DIG_IMN.2 10003 0 BOOL | Good | 0/ 1:34.51 PM key 2 DIG_IN.2 M-020G1BBI002.2
LEDDZ vB.DIG_IMN.2 10004 0 BOOL | Good | 0/ 1:34.51 PM key 3 DIG_IN.3 M-020G1BBI00Z.3
LEDDZ vB.0IG_IM.4 10005 0 BOOL | Good | 0/ 1:34:561 PM key 4 DIG_IN.4 M-020G1EBI00Z2.4
LEDDZ vB.0IG_IMN.5 10006 0 BOOL | Good | 0 1:34.61 PM key & DIG_IN.5 M-020G1BBIN0Z.5
LEDOZ vB.DIG_IMN.E 10007, 0 BOOL | Good | 0 1:34.51 PM key € DIG_IN.B M-020G1BBI0Z.E
LEDOS_vB.DIG_IMN.7 10008 0 BOOL | Good 0/1:3451 PM key 7 DIG_IN.7 M-020G1BBIN0Z.7
LEDOB_wBINTC_1 42560 1 INT Good 0 1:34:51 PM INTC_1 OuT1ICT A
LEDOZ vB.INTC_2 42561 2/INT Good | 0 1:3461 PM| INTC_2 OUTZICTA
LEDDS vB.INTC_3 42562 3INT Good | 0 1:3451 PM| INTC_3 OUTZICTA
LEDDZ vB.TOTAL 42563 3INT Good | 0 1:34:51 PM| TOTAL ouUT.ADDA
LEDO3 vB.RTC_Sec 43951 44 WORD | Good | 0 1:34:51 PM Seconds [RTC) RTC_Sec RTC_Sec

LEDDZ vB.RTC_Min 43352 33 WORD | Good | 0 1:34.51 PM Minutes [RTC) RTC_Min RTC_Min
LEDO8_vB.RTC_Hour 43353 10 W0ORD | Good 0/1:3451 PM How [RTC) RTC_Hour RTC_Hour
LEDOE_vB.RTC_Dweek 43954 4 WORD Good 0 1:34:51 PM | Day-of-week [RTC) RTC_Dweek RATC_Dweek
LEDOZ vB.RTC_Day 43365 1 WORD | Good | 0 1:3451 PM Day [RTC) RTC_Day RTC_Day

LEDDZ vB.RTC_Man 43556 E WORD | Good | 0/ 1:34.51 PM Manth (RTC) RTC_Mon RTC_Mon

LEDOZ vB.RTC Vear 43957 5 W0ORD | Good | 0/ 1:34:561 PM| Year [RTC] RTC_Vear RTC_‘ear
LEDOS_vB.5canCycleTime 43958 10 w0ORD | Good | 0/1:3451 PM| LC700 CPU Scan Cycle tin) ScanCyclaTime ScanCyclaTime
LEDOS vB.TEMPO 02001, 0 BOOL | Good | 0/ 1:34.51 PM | first light TEMPO WhIBE1T1I1.0
LEDOS_+B.TEMP1 02002 0 BOOL | Good 0/1:34.51 PM | second light TEMP1 WIBE1T1I1.1
LEDOS_vB.TEMP2 02003 0 BOOL | Good 0 1:34:51 PM | third light TEMP2 WMIBG1T11.2
LEDOZ vB.TEMP2 02004 0 BOOL | Good | 0/1:34:51 PM  faurth light TEMPZ WI1BGE1T1I1.3
LEDOS vB.TEMP4 02005 0 BOOL | Good | 0/ 1:34:51 PM | fith light TEMP4 WIBE1T1I1.4
LEDOZ vB.TEMPE 02006 0 BOOL | Good | 0/ 1:34:51 PM  sisth light TEMPE WhIBE1T1I1.5
LEDOS vB.TEMPE 02007 0 BOOL | Good | 0/ 1:34:51 PM | seventh light TEMPE WIBE1T1I1.6
LEDOZ +B8.0IG_0UT1.3 00004 0 BOOL | Good | 0 1:34.51 PM | led3 DIG_0OUT1.3 M-122G1B40003.3
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Figure 33-Monitoring example of the LC700 OPC Server using OPC Monitor
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